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1 Introduction: The CALPHAD Ecosystem

1.1 Course Context

� Learning Goal

Understand the structure of thermodynamic databases, master three accessible CAL-
PHAD software tools (Pandat, OpenCalphad, MatCalc), and learn about ongoing
efforts to standardize database formats through XML.

In Lecture 01, we introduced the CALPHAD method and its applications. Now we
dive deeper into the practical implementation: the databases that store thermodynamic
parameters and the software tools that use them to calculate phase equilibria.

Lecture 02 Focus:

• Structure and format of thermodynamic databases

• Three accessible software packages (up to 3 components)

• Hands-on tutorials for each software

• The XML standardization initiative

• SGTE binary database collection

1.2 The CALPHAD Workflow Revisited

CALPHAD Computational Chain:

Experimental Data
↓

Critical Assessment
↓

Parameter Optimization
↓

Thermodynamic Database (TDB)
↓

CALPHAD Software
↓

Phase Diagrams & Properties
↓

Materials Design Decisions

Figure 1: The flow from data to decisions in CALPHAD methodology
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Today’s focus: The database format (TDB) and the software layer.

2 Thermodynamic Database Structure

2.1 The TDB File Format

The standard thermodynamic database format uses files with .TDB extension containing:

1. Element definitions: Pure elements and their reference states

2. Species definitions: Compounds and ions

3. Phase definitions: Crystal structures and sublattice models

4. Thermodynamic functions: Gibbs energy expressions

5. Model parameters: Interaction parameters for solutions

2.2 Anatomy of a TDB File

2.2.1 Basic Structure

1 $ Database file created by [Author]
2 $ Date: [Date]
3 $ Elements and reference states
4

5 ELEMENT CU FCC_A1 63.546 5.004E+03 3.3150E+01 !
6 ELEMENT ZR HCP_A3 91.224 5.5663E+03 3.9181E+01 !
7

8 $ Phase definitions
9

10 PHASE LIQUID:L % 1 1.0 !
11 CONSTITUENT LIQUID:L :CU,ZR: !
12

13 PHASE FCC_A1 % 2 1 1 !
14 CONSTITUENT FCC_A1 :CU,ZR: :VA: !
15

16 $ Thermodynamic parameters
17

18 FUNCTION GHSERCU 298.15
19 -7770.458+130.485235*T -24.112392*T*LN(T)
20 -.00265684*T**2+1.29223E-07*T**3+52478*T**(-1); 1357.77 Y
21 -13542.026+183.803828*T -31.38*T*LN(T)
22 +3.64643E+29*T**( -9); 3200 N !
23

24 $ Binary interaction parameters
25

26 PARAMETER L(LIQUID ,CU,ZR;0) 298.15 -41788+10.109*T; 6000 N !
27 PARAMETER L(LIQUID ,CU,ZR;1) 298.15 -5912; 6000 N !
28

29 $ End of database

5
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Listing 1: Simplified TDB file structure

2.3 Key Components Explained

2.3.1 Element Definitions

1 ELEMENT <SYMBOL > <REF_PHASE > <MASS > <H298 > <S298 > !
2

3 Example:
4 ELEMENT CU FCC_A1 63.546 5004.0 33.150 !
5 | | | | |
6 | | | | Entropy at 298.15K (J/mol/K)
7 | | | Enthalpy at 298.15K (J/mol)
8 | | Atomic mass (g/mol)
9 | Reference phase (stable at 298.15K, 1 bar)

10 Element symbol

Listing 2: Element definition syntax

2.3.2 Phase Definitions

1 PHASE FCC_A1 % 2 1 1 !
2 CONSTITUENT FCC_A1 :CU,ZR,AL: :VA: !
3

4 Explanation:
5 - Phase name: FCC_A1 (Face -Centered Cubic)
6 - % 2: Two sublattices
7 - 1 1: Site ratios (1:1 in this case)
8 - :CU,ZR,AL:: First sublattice can be Cu, Zr , or Al
9 - :VA:: Second sublattice for vacancies (interstitial sites)

Listing 3: Phase definition with sublattice model

2.3.3 Gibbs Energy Functions

The heart of CALPHAD databases: polynomial expressions for Gibbs energy.

Gϕ
i (T ) = a+ bT + cT ln(T ) + dT 2 + eT 3 + fT−1 + . . . (1)

1 FUNCTION GHSERCU 298.15
2 -7770.458+130.485235*T -24.112392*T*LN(T)
3 -.00265684*T**2+1.29223E-07*T**3+52478*T**(-1); 1357.77 Y
4 -13542.026+183.803828*T -31.38*T*LN(T)
5 +3.64643E+29*T**( -9); 3200 N !
6

7 Notes:
8 - Valid from 298.15 K to 1357.77 K (melting point)
9 - Y: continues to next temperature range

6
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10 - Second expression valid from 1357.77 K to 3200 K
11 - N: no further temperature ranges

Listing 4: Gibbs energy function example

2.3.4 Interaction Parameters

For solution phases, excess Gibbs energy is described by Redlich-Kister polynomials:

Gex = xixj

n∑
ν=0

νLi,j(xi − xj)
ν (2)

1 $ Liquid phase interaction between Cu and Zr
2 PARAMETER L(LIQUID ,CU,ZR;0) 298.15 -41788+10.109*T; 6000 N !
3 PARAMETER L(LIQUID ,CU,ZR;1) 298.15 -5912; 6000 N !
4

5 $ The ;0 and ;1 are the Redlich -Kister orders
6 $ Temperature -dependent for order 0, constant for order 1

Listing 5: Binary interaction parameters

2.4 Compound Energy Formalism

For phases with multiple sublattices:

Gϕ = srfGϕ + idGϕ + exGϕ (3)

Where:

• srfGϕ: Surface of reference (end members)

• idGϕ: Ideal mixing entropy

• exGϕ: Excess Gibbs energy

� LLM Tip

Using LLMs to Understand TDB Files:
Paste a section of TDB file to Claude/DeepSeek:

"Explain this TDB file section line by line:
[paste TDB code]

What thermodynamic model is being used? What do the
parameters represent physically? How would changing
L(LIQUID,CU,ZR;0) affect the phase diagram?"

LLMs excel at parsing and explaining parameter meanings!

7
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3 Software Tool 1: Pandat by Computherm

3.1 Overview

ø Software Highlight

Pandat - PANhellenic phase Diagram And Thermodynamics
Developer: CompuTherm LLC
Website: https://www.computherm.com
Free Version: PanPhaseDiagram (up to 3 components)
Key Features:

• Professional-grade thermodynamic calculations

• Extensive database libraries (with purchase)

• User-friendly graphical interface

• Scheil and equilibrium solidification

• Property diagram calculations

• Diffusion module (commercial version)

Free Version Limitations:

• Maximum 3 components (sufficient for this course!)

• Reduced database access

• No diffusion calculations

• Academic use only

8
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3.2 Installation and Setup

Hands-On Exercise

Exercise 2.1: Install and Configure Pandat
Step 1: Download

1. Visit https://www.computherm.com/software

2. Navigate to “Free Software” section

3. Download PanPhaseDiagram installer

4. Available for Windows, Mac, Linux

Step 2: Installation

1. Run installer with administrator privileges

2. Accept license agreement (read carefully!)

3. Choose installation directory

4. Complete installation

Step 3: First Launch

1. Open Pandat

2. Explore the interface layout

3. Check Help → Tutorial Videos

4. Verify workspace directory is accessible

Step 4: Load Example Database

1. File → Open Workspace

2. Navigate to Examples folder

3. Open Cu-Zr binary system workspace

4. Observe database loaded in bottom panel

3.3 Interface Overview

Pandat Main Window Components:

9
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Table 1: Pandat Interface Elements
Component Function

Menu Bar File operations, calculations, settings
Toolbar Quick access to common functions
Database Panel Shows loaded TDB file contents
Calculation Panel Set up phase diagram and property calculations
Table View Display numerical results
Plot Window Interactive phase diagrams and plots
Console Calculation log and error messages

10
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3.4 Basic Calculations with Pandat

3.4.1 Binary Phase Diagram

Hands-On Exercise

Exercise 2.2: Calculate Cu-Zr Binary Phase Diagram
Step-by-Step Procedure:
1. Load Database

• File → Open Database

• Select Cu-Zr TDB file (provided in course materials)

• Or: Download from CPDDB (https://cpddb.nims.go.jp/)

2. Set Up Calculation

• Calculation → Phase Diagram

• X-axis: Select "X(ZR)" (mole fraction of Zr)

• Y-axis: Select "T" (Temperature in °C or K)

• Set ranges:

– X(ZR): 0 to 1 (pure Cu to pure Zr)

– T: 600 to 2200 K

• Set step sizes: 0.01 for composition, 10 K for temperature

3. Run Calculation

• Click "Calculate" button

• Monitor progress in console

• Wait for completion (usually < 1 minute)

4. Analyze Results

• Observe phase regions: Liquid, FCC, HCP, intermetallics

• Identify eutectic points

• Note peritectic reactions

• Check liquidus and solidus lines

5. Export Data

• Right-click on plot → Export Data

• Save as Excel or CSV format

• Use data for further analysis in MATLAB/Octave

Expected Result:

• Liquidus temperature at X(Zr)=0: 1358 K (Cu melting point)

• Liquidus temperature at X(Zr)=1: 2128 K (Zr melting point)

• Several intermetallic phases (CuZr, CuZr2, etc.)

• Eutectic reaction around X(Zr) ≈ 0.62

11
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3.4.2 Solidification Simulation

Hands-On Exercise

Exercise 2.3: Scheil Solidification of Cu-5wt%Zr
Setup:

1. Calculation → Scheil Solidification

2. Set composition: Cu-5wt%Zr (or Cu-95Zr in mole percent)

3. Temperature range: 1400 K to 1000 K

4. Save each solid fraction: 0.01 increment

Execute:

1. Run calculation

2. Observe solidification path

3. Note phases forming during cooling

Results to Extract:

• Solidification start temperature (liquidus)

• Solidification end temperature (final eutectic)

• Phase fractions vs. temperature

• Liquid composition evolution

Compare with Lever Rule:

1. Run equilibrium solidification (Lever rule)

2. Export both datasets

3. Plot T vs. fs for both models

4. Calculate growth restriction factor Q from both

5. Discuss differences

LLM Integration:

Export data to Excel, then ask Claude:
"Analyze this Scheil solidification data. Calculate the
growth restriction factor and compare with the Lever rule
prediction. Generate MATLAB code to visualize the difference."

12
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3.5 Advanced Pandat Features

3.5.1 Ternary Phase Diagrams

For Cu-Zr-Al system (relevant to bulk metallic glasses):
1 Calculation -> Phase Diagram
2 X-axis: X(ZR) from 0 to 1
3 Y-axis: X(AL) from 0 to 1
4 Fixed: T = 1000 K (isothermal section)
5

6 Or for liquidus projection:
7 X-axis: X(ZR)
8 Y-axis: X(AL)
9 Z-axis: T (automatic liquidus calculation)

Listing 6: Pandat ternary diagram setup

3.5.2 Property Diagrams

Calculate properties as function of composition or temperature:

• Heat capacity (Cp)

• Enthalpy of mixing

• Volume and density

• Activity coefficients

• Partial molar properties

13
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3.6 Pandat Resources

[ Resource

Learning Resources for Pandat:
Official Resources:

• Tutorial Videos: https://computherm.com/videos

• User Manual: Included with installation

• Example Workspaces: In installation directory

• Technical Support: support@computherm.com

Course Materials:

• Cu-Zr binary workspace: http://www.gotrawama.eu/metallurgia23/
CuMiani2018Binaries.zip

• Tutorial datasets: Available on course website

Database Sources:

• CPDDB (free registration): https://cpddb.nims.go.jp/

• SGTE collection (see Section 8)

• Custom databases from research collaborations

14
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4 Software Tool 2: OpenCalphad

4.1 Overview

ø Software Highlight

OpenCalphad (OC) - Open Source CALPHAD Software
Developer: Bo Sundman and collaborators
Website: http://www.opencalphad.com
License: Free and open source
Key Features:

• Fully open source (GPL license)

• Command-line and GUI interfaces

• Compatible with standard TDB format

• No limitations on number of components

• Advanced equilibrium algorithms

• Actively developed and maintained

• Cross-platform (Windows, Mac, Linux)

Advantages:

• Free for all uses (academic and commercial)

• Source code available for learning

• Can be integrated into custom workflows

• Direct developer community support

Considerations:

• Steeper learning curve than GUI-based tools

• Requires familiarity with command-line operations

• Documentation less extensive than commercial software

• GUI less polished than commercial alternatives

15
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4.2 Installation

Hands-On Exercise

Exercise 2.4: Install OpenCalphad
Windows Installation:

1. Visit http://www.opencalphad.com/downloads.html

2. Download Windows installer (OC-setup.exe)

3. Run installer with admin rights

4. Accept GPL license

5. Choose installation directory (e.g., C:\OpenCalphad)

6. Complete installation

Linux Installation:

# Download source code
g i t c l one https : // github . com/sundmanbo/opencalphad . g i t
cd opencalphad

# Bui ld from source
make

# I n s t a l l (may r e qu i r e sudo )
make i n s t a l l

# Test i n s t a l l a t i o n
oc6

Mac Installation:

1. Install Xcode command-line tools

2. Follow Linux build instructions

3. Or: Download pre-compiled binary from website

Verify Installation:

# Open command prompt/ termina l
# Navigate to OpenCalphad d i r e c t o r y
cd /path/ to /opencalphad

# Run OpenCalphad
oc6

# You shou ld see :
# OpenCalphad ve r s i on X.X
# Command prompt : oc>

16
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4.3 OpenCalphad Macro Language

OpenCalphad uses a macro language for calculations. Basic structure:
1 @@ Sample macro for Cu-Zr phase diagram calculation
2

3 $ Set verbosity level
4 set -echo
5

6 $ Read thermodynamic database
7 read -tdb CuZr2018.tdb
8

9 $ Select elements for calculation
10 select -elements cu zr
11 reject -phase *
12 restore -phase liquid fcc_a1 hcp_a3
13

14 $ Set conditions
15 set -condition n=1 T=1300 p=1e5
16 set -condition x(cu)=0.5
17

18 $ Calculate equilibrium
19 calculate -equilibrium
20

21 $ List stable phases
22 list -phase
23

24 $ Perform axis calculation (phase diagram)
25 set -axis -variable 1 x(zr) 0 1 0.01
26 set -axis -plot -status x(zr) x T
27 step -separate -phases
28

29 $ Plot results
30 plot
31

32 $ Export data
33 save -workspace CuZr_diagram

Listing 7: OpenCalphad macro example

17
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4.4 Basic OpenCalphad Workflow

Hands-On Exercise

Exercise 2.5: Calculate Phase Diagram with OpenCalphad
Step 1: Prepare Database

1. Download Cu-Zr TDB file

2. Place in OpenCalphad working directory

3. Verify filename (e.g., CuZr.tdb)

Step 2: Create Macro File
Create file CuZr_diagram.OCM:

1 $ Cu-Zr Binary Phase Diagram Macro
2 set -echo
3

4 $ Load database
5 read -tdb CuZr.tdb
6

7 $ Select system
8 select -elements cu zr
9

10 $ Define conditions
11 set -condition n=1 p=101325
12 set -condition t=1300
13

14 $ Calculate T-X diagram
15 set -axis -variable 1 x(zr) 0 1 0.02
16 set -axis -variable 2 t 800 2200 20
17

18 $ Run calculation
19 step
20

21 $ Save results
22 save -workspace CuZr_result
23

24 $ Exit
25 exit

Step 3: Execute Macro

# From command l i n e
oc6 CuZr_diagram .OCM

# Or from wi th in OC:
oc> @$ CuZr_diagram

Step 4: Visualize Results

• Use built-in plotting (if available)

• Or: Export data and plot in MATLAB/Octave

• Or: Use Python matplotlib

18
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4.5 OpenCalphad GUI (OCASI)

Recent versions include a graphical interface:

• Launch: Run ocasi executable

• Features:

– Database browser

– Interactive phase diagram plotting

– Equilibrium calculator

– Property calculations

• Workflow:

1. Load TDB file

2. Select elements

3. Choose calculation type

4. Set conditions

5. Calculate and visualize

19
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4.6 OpenCalphad Resources

[ Resource

OpenCalphad Learning Resources:
Official Documentation:

• Website: http://www.opencalphad.com

• User Guide: Available on website

• YouTube Tutorial: Prof. Bo Sundman’s lectures

– https://www.youtube.com/watch?v=mIRvrIzSj7I

• Source Code: https://github.com/sundmanbo/opencalphad

Community Support:

• GitHub Issues: Report bugs and ask questions

• CALPHAD community forums

• Direct contact with Bo Sundman (for serious inquiries)

Example Files:

• Included in installation directory

• Example macros for common calculations

• Test databases for verification

20
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5 Software Tool 3: MatCalc

5.1 Overview

ø Software Highlight

MatCalc - Materials Calculator
Developer: MatCalc Engineering GmbH (TU Wien spin-off)
Website: https://www.matcalc.at
Free Version: MatCalc 6 (limited to 3 elements)
Key Features:

• Comprehensive thermodynamic and kinetic calculations

• Precipitation simulation

• Diffusion modeling

• Mean-field precipitation kinetics

• Professional GUI with scripting capability

• Excellent steel databases

Unique Strengths:

• Precipitation modeling (carbides, nitrides, etc.)

• Heat treatment simulation

• TTT/CCT diagram calculation

• Grain growth and recrystallization

• Integrated with experimental databases

Free Version Limitations:

• Maximum 3 elements

• Reduced database access

• Some advanced modules locked

• Academic/evaluation use only
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5.2 Installation and Setup

Hands-On Exercise

Exercise 2.6: Install MatCalc
Step 1: Registration

1. Visit https://www.matcalc.at

2. Navigate to Downloads section

3. Register for free account (academic email preferred)

4. Verify email address

Step 2: Download

1. Log in to download area

2. Download MatCalc 6 Free Version

3. Download example databases

4. Download documentation

Step 3: Installation

1. Run installer (MatCalc_6_Setup.exe)

2. Accept license agreement

3. Choose installation directory

4. Install databases in default location

5. Complete installation

Step 4: First Launch

1. Start MatCalc 6

2. Explore GUI layout

3. Check Help → Getting Started

4. Verify database directory is accessible

5.3 MatCalc Interface

Main Window Components:
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Table 2: MatCalc Interface Elements
Component Function

Menu Bar File operations, calculations, modules
Toolbar Quick access icons
Tree View Hierarchical view of calculation objects
Console Command input and script execution
Plot Window Interactive plots and diagrams
Table View Numerical results display
Status Bar Calculation progress and messages
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5.4 Basic MatCalc Calculations

5.4.1 Setting Up a Calculation

Hands-On Exercise

Exercise 2.7: Binary Phase Diagram with MatCalc
Step 1: Load Database

1. File → Open Database

2. Select appropriate database (e.g., mc_fe.tdb for steels)

3. For Cu-Zr: Use custom or SGTE database if available

Step 2: Define System

1. Edit → System Setup

2. Select elements: Fe, C (for simple steel example)

3. Set system size: 1 mole

4. Confirm selection

Step 3: Phase Selection

1. Edit → Phase Setup

2. Enable relevant phases:

• LIQUID

• FCC_A1 (austenite)

• BCC_A2 (ferrite)

• CEMENTITE (Fe3C)

3. Disable phases not needed

Step 4: Set Conditions

1. Edit → Set Conditions

2. Pressure: 1E5 Pa (1 bar)

3. Temperature: 1000 K (will vary for diagram)

4. Composition: x(C) = 0.02 (2 mole% C)

Step 5: Calculate Equilibrium

1. Calculation → Equilibrium → Calculate

2. View results in table

3. Check stable phases

4. Examine phase fractions

Step 6: Generate Phase Diagram

1. Calculation → Phase Diagram

2. X-axis: x(C) from 0 to 0.1

3. Y-axis: T from 600 to 1800 K

4. Calculate

5. View interactive plot
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5.4.2 MatCalc Scripting

MatCalc includes powerful scripting for automation:
1 $ Fe-C binary phase diagram script
2

3 $ Open database
4 open -database mc_fe.tdb
5

6 $ Select elements
7 select -elements fe c
8 select -phase liquid fcc_a1 bcc_a2 cementite
9

10 $ Define conditions
11 set -condition p=1e5 n=1
12

13 $ Create stepped calculation
14 create -stepped -equilibrium -calculation
15 set -start -value x(c)=0
16 set -end -value x(c)=0.1
17 set -step -size x(c)=0.001
18 set -start -value t=600
19 set -end -value t=1800
20 set -step -size t=10
21

22 $ Execute
23 start -stepped -equilibrium -calculation
24

25 $ Export results
26 export -data phase_diagram.txt
27

28 $ Plot
29 create -plot
30 add -curve x(c) t
31 set -plot -title "Fe -C Binary Phase Diagram"
32 show -plot

Listing 8: MatCalc script example

5.5 MatCalc for Precipitation

Unique capability: simulating precipitation during heat treatment.
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Hands-On Exercise

Exercise 2.8: Precipitation Simulation (Advanced)
Scenario: Carbide precipitation in tool steel during tempering
Setup:

1. Load steel database

2. Define composition: Fe-0.5C-5Cr-1Mo (wt%)

3. Enable phases: Matrix + carbide phases

4. Set initial condition: 1000°C (austenite)

5. Define heat treatment:

• Quench to 500°C

• Hold for 3600 seconds (tempering)

Calculate:

1. Precipitation → Mean-field calculation

2. Set nucleation model

3. Set growth model

4. Run simulation

Results:

• Precipitate size distribution

• Volume fraction evolution

• Hardness prediction

• Matrix composition change

Note: This advanced feature showcases MatCalc’s kinetic capabilities beyond equi-
librium thermodynamics.
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5.6 MatCalc Resources

[ Resource

MatCalc Learning Resources:
Official Resources:

• Website: https://www.matcalc.at

• Documentation: Comprehensive PDF manual

• Tutorial Videos: Available on website

• Example Files: Included with installation

• Workshops: Regular training events (check website)

Academic Support:

• TU Wien materials science group

• Publications using MatCalc (extensive literature)

• User forum on website

Databases:

• mc_fe: Comprehensive steel database

• mc_al: Aluminum alloys

• mc_ni: Nickel superalloys

• Custom databases can be created
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6 Software Comparison and Selection

6.1 Feature Comparison

Table 3: Comparison of Three CALPHAD Software Tools
Feature Pandat OpenCalphad MatCalc

Cost (Free Ver.) Free (3 elem.) Fully free Free (3 elem.)
Platform Win/Mac/Linux Win/Mac/Linux Windows
User Interface Excellent GUI CLI + basic GUI Excellent GUI
Learning Curve Easy Moderate Moderate
Documentation Excellent Good Excellent
Phase Diagrams
Solidification
Precipitation
Diffusion Commercial
Scripting Limited
Open Source
Databases Commercial User-provided Included
Steel Focus General General

6.2 Which Tool to Use When?

Use Pandat when:

• You need professional-quality phase diagrams quickly

• You want intuitive GUI with minimal learning

• You’re doing equilibrium thermodynamics only

• You have access to Pandat databases

Use OpenCalphad when:

• You want complete freedom (open source)

• You need to automate calculations

• You want to understand algorithms deeply

• You’re developing custom workflows

• No budget constraints matter

Use MatCalc when:

• You’re working with steels
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• You need precipitation simulations

• You want kinetic calculations

• You’re simulating heat treatments

• You need TTT/CCT diagrams

Use all three when:

• You want to cross-validate results

• You’re learning CALPHAD methods thoroughly

• Different tools suit different project phases

7 The XML Standardization Initiative

7.1 The Problem: TDB Format Babel

e Current Research

Current Challenge in CALPHAD Community:
The TDB format, while widely used, has significant issues:
Problems:

• No formal specification: Format evolved organically

• Vendor-specific extensions: Each software adds proprietary syntax

• Limited metadata: Difficult to track provenance

• Poor version control: Hard to manage database evolution

• Ambiguous parsing: Different interpretations possible

• Human-readable only: Not ideal for machine processing

Result: "Babel Tower" of incompatible formats!
Different software tools sometimes cannot read each other’s TDB files, hindering
collaboration and reproducibility.
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7.2 The XML Solution

e Current Research

Prof. Fabio Miani and Collaborators’ Initiative:
Team:

• Prof. Fabio Miani (University of Udine)

• Prof. Bo Sundman (KTH Stockholm, OpenCalphad developer)

• Dr. Bengt Hallstedt (RWTH Aachen)

• Other CALPHAD community members

Goal: Develop XML-based standard for thermodynamic databases
Advantages of XML Format:

1. Well-defined schema: Formal XSD specification

2. Validation: Automatic checking of database structure

3. Extensibility: Easy to add new features

4. Metadata: Rich provenance and versioning info

5. Machine-readable: Easy parsing by software

6. Human-readable: Still understandable by humans

7. Tool support: Standard XML editors and validators

8. Interoperability: Universal standard across platforms

7.3 XML TDB Structure Example

1 <?xml version="1.0" encoding="UTF -8"?>
2 <thermodynamicDatabase xmlns="http://www.calphad.org/xml/tdb"
3 version="1.0">
4

5 <metadata >
6 <title>Cu-Zr Binary System Assessment </title>
7 <author >Hsiao , H.-M. et al.</author >
8 <date>2016 -12 -01</date>
9 <reference >CALPHAD 55 (2016) 77-87</reference >

10 <doi>10.1016/j.calphad .2016.08.001 </doi>
11 <version >2.0</version >
12 </metadata >
13

14 <elements >
15 <element symbol="CU">
16 <mass unit="g/mol">63.546 </mass>
17 <referencePhase >FCC_A1 </referencePhase >
18 <enthalpy298 unit="J/mol">5004.0 </enthalpy298 >
19 <entropy298 unit="J/mol/K">33.150 </entropy298 >
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20 </element >
21

22 <element symbol="ZR">
23 <mass unit="g/mol">91.224 </mass>
24 <referencePhase >HCP_A3 </referencePhase >
25 <enthalpy298 unit="J/mol">5566.3 </enthalpy298 >
26 <entropy298 unit="J/mol/K">39.181 </entropy298 >
27 </element >
28 </elements >
29

30 <phases >
31 <phase name="LIQUID">
32 <type>liquid </type>
33 <sublattices count="1">
34 <sublattice index="1" stoichiometry="1.0">
35 <species >CU</species >
36 <species >ZR</species >
37 </sublattice >
38 </sublattices >
39 </phase>
40

41 <phase name="FCC_A1">
42 <type>substitutional_solution </type>
43 <sublattices count="2">
44 <sublattice index="1" stoichiometry="1.0">
45 <species >CU</species >
46 <species >ZR</species >
47 </sublattice >
48 <sublattice index="2" stoichiometry="1.0">
49 <species >VA</species >
50 </sublattice >
51 </sublattices >
52 </phase>
53 </phases >
54

55 <functions >
56 <function name="GHSERCU" type="gibbs_energy">
57 <temperatureRange min="298.15" max="1357.77" unit="K">
58 <expression >
59 -7770.458 + 130.485235*T - 24.112392*T*LN(T)
60 - 0.00265684*T**2 + 1.29223E-07*T**3 + 52478*T**(-1)
61 </expression >
62 </temperatureRange >
63 <temperatureRange min="1357.77" max="3200" unit="K">
64 <expression >
65 -13542.026 + 183.803828*T - 31.38*T*LN(T)
66 + 3.64643E+29*T**(-9)
67 </expression >
68 </temperatureRange >
69 </function >
70 </functions >
71

72 <parameters >
73 <parameter type="interaction">
74 <phase >LIQUID </phase>
75 <constituents >
76 <constituent sublattice="1">CU</constituent >
77 <constituent sublattice="1">ZR</constituent >
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78 </constituents >
79 <order >0</order>
80 <expression > -41788 + 10.109*T</expression >
81 <temperatureRange min="298.15" max="6000" unit="K"/>
82 <reference >Hsiao et al. (2016) </reference >
83 </parameter >
84 </parameters >
85

86 </thermodynamicDatabase >

Listing 9: XML thermodynamic database structure concept

7.4 Benefits of XML Format

For Database Developers:

• Structured editing with validation

• Version control friendly (better diff)

• Automated quality checks

• Rich metadata embedding

For Software Developers:

• Standard parsing libraries available

• No ambiguity in interpretation

• Easy to extend without breaking compatibility

• Automatic documentation generation

For Users/Researchers:

• Database provenance tracking

• Easier to understand database content

• Better reproducibility

• Universal compatibility across tools
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7.5 Current Status and Future

e Current Research

Project Status (as of 2026):
Completed:

• XML schema definition (XSD)

• Proof-of-concept converters (TDB ↔ XML)

• Validation tools

• Example databases in XML format

Ongoing:

• Community feedback and refinement

• Integration with existing software

• Extension to cover all TDB features

• Development of best practices

Future Goals:

• Adoption by major software vendors

• XML as primary format for new databases

• Integration with materials databases

• Automated database generation from ML

How to Participate:

• Contact Prof. Miani or Prof. Sundman

• Join CALPHAD community discussions

• Test XML tools and provide feedback

• Contribute to open-source implementations
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8 SGTE Binary Database Collection

8.1 Introduction to SGTE

[ Resource

SGTE - Scientific Group Thermodata Europe:
Background:

• Founded in 1980s

• European consortium for thermodynamic data

• Gold standard for thermodynamic assessments

• Systematic assessment methodology

Publications:

• SGTE Pure Elements Database (SGTE Unary)

• SGTE Binary Solutions Database

• Landolt-Börnstein compilations

• Numerous individual assessments
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8.2 Bengt Hallstedt’s Binary Database Release

e Current Research

Major Development: SGTE Binary Databases Now Available:
Contributor: Dr. Bengt Hallstedt (RWTH Aachen University)
Co-author with Prof. Miani and collaborators, Dr. Hallstedt has made available a
comprehensive collection of SGTE binary system databases.
Contents:

• Hundreds of critically assessed binary systems

• Based on SGTE methodology

• Peer-reviewed assessments

• Compatible with standard CALPHAD software

• Regular updates and corrections

Quality Standards:

• Experimental data compilation

• Critical evaluation of literature

• Thermodynamic modeling

• Validation against experiments

• Peer review process

Access:

• Available through research collaborations

• Contact Dr. Hallstedt or Prof. Miani

• Some systems available via CPDDB

• Academic use typically permitted
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8.3 Using SGTE Databases

Hands-On Exercise

Exercise 2.9: Working with SGTE Binary Data
Objective: Load and validate SGTE binary assessment
Procedure:
Step 1: Obtain Database

• Download from course materials or CPDDB

• Example: Cu-Zr SGTE assessment

• Save as CuZr_SGTE.tdb

Step 2: Load in Multiple Software

• Load in Pandat

• Load in OpenCalphad

• Load in MatCalc (if format compatible)

Step 3: Calculate Reference Diagram

• Calculate binary phase diagram

• Export key invariant points:

– Melting points

– Eutectic/peritectic temperatures

– Phase boundary compositions

Step 4: Compare with Literature

• Find original SGTE publication

• Compare calculated vs. published diagrams

• Verify within acceptable tolerance

• Document any discrepancies

Step 5: Document Provenance

• Record database source

• Note version and date

• Cite properly in your work

• Track modifications if any
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8.4 Quality Indicators in SGTE Databases

What makes SGTE assessments reliable:

1. Comprehensive data review:

• Phase diagram data

• Thermochemical measurements

• Crystal structure information

• Activity data

2. Consistent modeling:

• Standardized models for common phases

• Compatible with SGTE unary database

• Thermodynamically consistent parameters

3. Validation:

• Reproduction of experimental data

• Thermodynamic plausibility checks

• Extrapolation behavior assessment

4. Documentation:

• Detailed assessment reports

• Parameter tables

• Comparison with previous work

• Identified uncertainties

9 Practical Workflows and Integration

9.1 Multi-Software Workflow

Recommended research workflow:
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Integrated CALPHAD Workflow:
Phase 1: Initial Exploration (Pandat)

• Quick phase diagram visualization

• Identify key compositions

• Screen alloy systems

↓
Phase 2: Detailed Calculation (OpenCalphad)

• Automated batch calculations

• Custom property evaluations

• Integration with MATLAB/Python

↓
Phase 3: Kinetic Simulation (MatCalc)

• Precipitation modeling

• Heat treatment optimization

• Microstructure prediction

↓
Phase 4: Data Analysis (MATLAB/Octave + LLM)

• Statistical analysis

• Visualization

• Report generation

Figure 2: Multi-tool research workflow
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9.2 Database Management Best Practices

. Important

Critical Database Management Practices:
1. Version Control:

• Always record database version

• Use git or similar for tracking

• Document all modifications

• Never overwrite original files

2. Provenance Tracking:

• Source: Where did database come from?

• Author: Who created/assessed it?

• Date: When was it published/created?

• Reference: Peer-reviewed publication?

3. Validation:

• Test against known results

• Compare with experimental data

• Check thermodynamic consistency

• Verify extrapolation behavior

4. Documentation:

• Maintain README files

• Log all calculations

• Record software versions used

• Note any assumptions or modifications

5. Backup:

• Regular backups of databases

• Store in multiple locations

• Use cloud storage with version history

• Archive with project data
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9.3 LLM-Assisted Database Work

� LLM Tip

How to Use Claude/DeepSeek for Database Tasks:
1. Understanding TDB Files:

Prompt: "Explain this TDB file section. What thermodynamic
model is used? What do the parameters represent physically?"
[Paste TDB excerpt]

2. Converting Formats:

Prompt: "Convert this TDB parameter to XML format following
the schema we discussed. Ensure all metadata is preserved."

3. Generating Analysis Scripts:

Prompt: "Create a MATLAB script that:
1. Loads multiple TDB files
2. Extracts liquidus temperatures for Cu-X systems
3. Plots comparison chart
4. Identifies outliers"

4. Literature Research:

Prompt: "Find the original SGTE assessment for Cu-Zr system.
What experimental data did they use? What were the main
challenges in the assessment?"

5. Validation Assistance:

Prompt: "I calculated a Cu-Zr eutectic at 1173 K and x(Zr)=0.65.
The literature reports 1186 K and x(Zr)=0.62. Is this
discrepancy acceptable? What could cause it?"
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10 Student Assignments

10.1 Assignment 2.1: Software Mastery

Hands-On Exercise

Assignment 2.1: Master Three CALPHAD Tools
Objective: Demonstrate proficiency with Pandat, OpenCalphad, and MatCalc
Tasks:
Part A: Installation and Verification (20%)

1. Install all three software packages

2. Document installation process

3. Run test calculations in each

4. Screenshot key interface elements

Part B: Binary Phase Diagram (30%)

1. Choose a binary system from SGTE collection

2. Calculate phase diagram in all three software

3. Export numerical data from each

4. Create comparison plot showing all three results

5. Discuss any differences observed

Part C: Solidification Simulation (30%)

1. Select Cu-Zr-Al composition

2. Run Scheil solidification in Pandat

3. Calculate growth restriction factor

4. Compare with Lever rule prediction

5. Generate professional report with plots

Part D: Advanced Feature (20%)

• Pandat users: Ternary liquidus projection

• OpenCalphad users: Automated script for batch processing

• MatCalc users: Precipitation simulation

Deliverables:

• Technical report (10-12 pages)

• All calculation files (TDB, workspaces, scripts)

• Exported data (Excel/CSV)

• Comparison plots

• LLM interaction log (if used for assistance)

Grading Rubric:

• Technical accuracy: 40%

• Software proficiency: 30%

• Data analysis and interpretation: 20%

• Documentation quality: 10%
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10.2 Assignment 2.2: Database Analysis Project

Hands-On Exercise

Assignment 2.2: SGTE Database Comparative Study
Objective: Compare different database assessments for the same system
Scenario: Multiple assessments exist for many binary systems. Your task is to
compare them critically.
Procedure:
Step 1: Database Collection

• Obtain 2-3 different TDB files for same binary system

• Example: Cu-Zr from different sources/years

• Document provenance of each

Step 2: Phase Diagram Comparison

• Calculate phase diagrams from each database

• Identify differences in:

– Liquidus/solidus lines

– Invariant points (eutectic, peritectic)

– Intermetallic phase stability

– Phase boundary positions

Step 3: Literature Investigation

• Find original assessment publications

• Identify experimental data used

• Compare modeling approaches

• Note which assessment is more recent/comprehensive

Step 4: Critical Evaluation

• Which database appears more reliable? Why?

• What experimental data would resolve discrepancies?

• How do differences affect practical applications?

• Make recommendation for which to use

Step 5: LLM Assistance Documentation

• Use Claude/DeepSeek to understand differences

• Document prompts and responses

• Critically evaluate LLM analysis

• Verify against literature

Deliverables:

• Comprehensive comparison report (12-15 pages)

• Side-by-side phase diagram comparison

• Database files with provenance documentation

• Recommendation memo (1-2 pages)

• LLM interaction analysis
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11 Conclusion and Next Steps

11.1 Key Takeaways from Lecture 02

You have now learned:

1. TDB file structure: How thermodynamic databases are organized

2. Three software tools: Pandat, OpenCalphad, MatCalc capabilities

3. Practical workflows: How to use each tool effectively

4. XML standardization: Future direction for database formats

5. SGTE databases: High-quality binary assessments

6. Best practices: Database management and validation

11.2 Preparing for Lecture 03

Hands-On Exercise

Pre-Lecture 03 Tasks:
1. Software Proficiency

• Complete at least 3 calculations in your preferred tool

• Practice exporting data for MATLAB/Octave analysis

• Bookmark help documentation

2. Database Familiarity

• Download 2-3 binary TDB files from CPDDB

• Examine structure in text editor

• Load in different software and compare

3. LLM Integration

• Practice using Claude to explain TDB sections

• Generate MATLAB scripts for data analysis

• Build confidence with LLM-assisted workflow

4. Reading

• Review SGTE methodology papers

• Explore XML examples provided

• Read about compound energy formalism
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11.3 Looking Ahead

Upcoming Topics:

• Lecture 03: Ternary Systems and Liquidus Projections

• Lecture 04: Solidification Modeling in Depth

• Lecture 05: Growth Restriction and Grain Refinement

• Lecture 06: Advanced Applications and Case Studies
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11.4 Research Opportunities

e Current Research

Get Involved in CALPHAD Research:
Opportunities at University of Udine:

• XML standardization project (contact Prof. Miani)

• Database development for specific systems

• Integration of ML with thermodynamic databases

• Validation studies of new assessments

Broader Community:

• CALPHAD journal submissions

• Annual CALPHAD conference

• Open-source software contributions

• International collaborations

Skills You’re Developing:

• Thermodynamic modeling

• Software proficiency

• Data management

• LLM-assisted research

• Scientific communication

These skills are highly valued in:

• Materials design companies

• Process optimization firms

• Research institutions

• Software development (materials informatics)
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11.5 Additional Resources

[ Resource

Extended Learning Materials:
Books:

• “Computational Thermodynamics: The CALPHAD Method” by H. Lukas et al.

• “Thermodynamics of Alloys” by R.A. Swalin

• “Phase Transformations in Metals and Alloys” by D.A. Porter et al.

Online Courses:

• NIMS online tutorials

• Thermo-Calc Academy

• MatCalc webinars

Journals:

• CALPHAD: Computer Coupling of Phase Diagrams and Thermochemistry

• Metallurgical and Materials Transactions A

• Acta Materialia

Conferences:

• Annual CALPHAD meeting

• TMS Annual Meeting

• European Congress on Advanced Materials (EUROMAT)
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The future of thermodynamic databases is open, standardized, and collaborative!

Prof. Fabio Miani
University of Udine
fabio.miani@uniud.it

January 7, 2026

Æ Document Generation Note:
This lecture material was drafted using Anthropic Claude LLM (Sonnet 4.5)
through collaborative interaction with Prof. Fabio Miani on January 6, 2026.
All technical content has been reviewed for accuracy. Software features and URLs
were current as of the document creation date.
For latest information:

• Software updates: Check respective websites

• Database availability: Contact Prof. Miani or collaborators

• XML initiative: Follow updates on OpenCalphad website
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A Quick Reference: TDB Syntax

1 $ Comments start with dollar sign
2

3 $ Element definition
4 ELEMENT <SYMBOL > <REF_PHASE > <MASS > <H298 > <S298 > !
5

6 $ Phase definition
7 PHASE <NAME > %<MODEL > <SUBLATTICES > <SITE_RATIOS > !
8 CONSTITUENT <NAME > :<SPECIES_1 >: :<SPECIES_2 >: !
9

10 $ Function definition
11 FUNCTION <NAME > <T_LOW >
12 <EXPRESSION >; <T_HIGH > <CONTINUE > !
13

14 $ Parameter definition
15 PARAMETER <TYPE >(<PHASE >,<SPECIES >;<ORDER >) <T_LOW >
16 <EXPRESSION >; <T_HIGH > <CONTINUE > !
17

18 $ Common expressions
19 T Temperature
20 LN(T) Natural logarithm
21 ** Power operator
22 T**(-1) 1/T

Listing 10: Common TDB syntax patterns

B Software Command Quick Reference

B.1 Pandat GUI Shortcuts

Table 4: Pandat keyboard shortcuts
Shortcut Action

Ctrl+O Open workspace
Ctrl+S Save workspace
Ctrl+N New calculation
F5 Run calculation
Ctrl+E Export data
Ctrl+P Print plot
F1 Help

B.2 OpenCalphad Essential Commands

1 $ Database operations
2 read -tdb <filename >
3 save -tdb <filename >
4 list -database
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5

6 $ System setup
7 select -elements <el1 > <el2 > ...
8 select -phase <phase1 > <phase2 > ...
9 reject -phase <phase >

10 restore -phase <phase >
11

12 $ Conditions
13 set -condition n=<value > p=<value > t=<value >
14 set -condition x(<element >)=<value >
15 set -condition w(<element >)=<value >
16

17 $ Calculations
18 calculate -equilibrium
19 list -equilibrium
20 list -phase
21

22 $ Diagrams
23 set -axis -variable <n> <variable > <start > <end > <step >
24 step
25 plot
26

27 $ Workspace
28 save -workspace <name >
29 read -workspace <name >

Listing 11: OpenCalphad command reference

B.3 MatCalc Script Commands

1 $ Database and system
2 open -database <filename >
3 select -elements <el1 > <el2 > <el3 >
4 select -phase <phase_list >
5

6 $ Conditions
7 set -condition p=<value > n=<value >
8 set -condition t=<value >
9 set -condition w(<element >)=<value >

10

11 $ Equilibrium
12 calculate -equilibrium
13 list -phase -status
14

15 $ Phase diagram
16 create -stepped -equilibrium -calculation
17 set -start -value <variable >=<value >
18 set -end -value <variable >=<value >
19 set -step -size <variable >=<value >
20 start -stepped -equilibrium -calculation
21

22 $ Plotting
23 create -plot
24 add -curve <x-var > <y-var >
25 set -plot -title "<title >"
26 show -plot
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27

28 $ Export
29 export -data <filename >

Listing 12: MatCalc scripting basics

C Troubleshooting Common Issues

C.1 TDB File Loading Errors

Error: "Cannot parse TDB file"

Solutions:

1. Check for syntax errors (missing !, wrong keywords)

2. Verify encoding (use UTF-8 or ASCII)

3. Check for unsupported extensions (vendor-specific)

4. Try loading in different software to identify issue

5. Use text editor with syntax highlighting

C.2 Calculation Convergence Issues

Error: "Equilibrium calculation did not converge"

Solutions:

1. Check temperature is within valid range

2. Verify composition sums to 1.0

3. Try different starting point

4. Reduce step size

5. Check for database errors (impossible parameters)

6. Exclude metastable phases temporarily

C.3 Software-Specific Issues

Pandat:

• Workspace corruption: Delete .pan file and recreate

• Slow calculations: Reduce precision or grid density
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• Plot not updating: Refresh or recalculate

OpenCalphad:

• Command not recognized: Check spelling and syntax

• Macro errors: Run commands line-by-line to find issue

• Memory errors: Reduce calculation scope

MatCalc:

• License errors: Check installation and registration

• Missing phases: Verify database loaded correctly

• Script errors: Check variable names match database

D Contact and Support

Course Instructor:

• Prof. Fabio Miani

• University of Udine, Italy

• Email: fabio.miani@uniud.it

• Office hours: [To be announced]

Software Support:

• Pandat: support@computherm.com

• OpenCalphad: GitHub issues or Bo Sundman

• MatCalc: office@matcalc.at

Database Questions:

• SGTE databases: Dr. Bengt Hallstedt

• CPDDB: NIMS support portal

• XML initiative: Prof. Miani or Prof. Sundman

End of Lecture 02
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Next: Lecture 03 - Ternary Systems and Advanced Calculations
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